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General 
Precautions 

Read this entire manual and all other publications pertaining to the work to be 
performed before installing, operating, or servicing this equipment. 

Practice all plant and safety instructions and precautions. 

Failure to follow instructions can cause personal injury and/or property damage. 

 
 

 
 

Revisions 

This publication may have been revised or updated since this copy was produced. 
To verify that you have the latest revision, check manual 26311 , Revision Status & 
Distribution Restrictions of Woodward Technical Publications, on the publications 
page of the Woodward website: 

www.woodward.com/publications 
 
The latest version of most publications is available on the publications page. If 
your publication is not there, please contact your customer service representative 
to get the latest copy. 

 
 

 
 

Proper Use 

Any unauthorized modifications to or use of this equipment outside its specified 
mechanical, electrical, or other operating limits may cause personal injury and/or 
property damage, including damage to the equipment. Any such unauthorized 
modifications: (i) constitute "misuse" and/or "negligence" within the meaning of 
the product warranty thereby excluding warranty coverage for any resulting 
damage, and (ii) invalidate product certifications or listings. 

 
 

 
 

Translated 
Publications 

If the cover of this publication states "Translation of the Original Instructions" 
please note: 

The original source of this publication may have been updated since this 
translation was made. Be sure to check manual 26311 , Revision Status & 
Distribution Restrictions of Woodward Technical Publications, to verify whether 
this translation is up to date. Out-of-date translations are marked with . Always 
compare with the original for technical specifications and for proper and safe 
installation and operation procedures. 

 
 
 
 
 
 
Revisions—Changes in this publication since the last revision are indicated by a black line 

alongside the text. 
 
 
 
 
 
 
 
 
Woodward reserves the right to update any portion of this publication at any time. Information provided by Woodward is 
believed to be correct and reliable. However, no responsibility is assumed by Woodward unless otherwise expressly 
undertaken. 
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Warnings and Notices 
 
Important Definitions 

This is the safety alert symbol. It is used to alert you to potential 
personal injury hazards. Obey all safety messages that follow this 
symbol to avoid possible injury or death. 

 DANGER—Indicates a hazardous situation which, if not avoided, will result 
in death or serious injury. 

 WARNING—Indicates a hazardous situation which, if not avoided, could 
result in death or serious injury. 

 CAUTION—Indicates a hazardous situation which, if not avoided, could 
result in minor or moderate injury. 

 NOTICE—Indicates a hazard that could result in property damage only 
(including damage to the control). 

 IMPORTANT—Designates an operating tip or maintenance suggestion. 
 

 
 

Overspeed / 
Overtemperature / 

Overpressure 

The engine, turbine, or other type of prime mover should be 
equipped with an overspeed shutdown device to protect against 
runaway or damage to the prime mover with possible personal injury, 
loss of life, or property damage. 

The overspeed shutdown device must be totally independent of the 
prime mover control system. An overtemperature or overpressure 
shutdown device may also be needed for safety, as appropriate. 

 

 
 

Personal Protective 
Equipment 

The products described in this publication may present risks that 
could lead to personal injury, loss of life, or property damage. 
Always wear the appropriate personal protective equipment (PPE) for 
the job at hand. Equipment that should be considered includes but is 
not limited to: 
 Eye Protection 
 Hearing Protection 
 Hard Hat 
 Gloves 
 Safety Boots 
 Respirator 

Always read the proper Material Safety Data Sheet (MSDS) for any 
working fluid(s) and comply with recommended safety equipment. 

 

 
 

Start-up 

Be prepared to make an emergency shutdown when starting the 
engine, turbine, or other type of prime mover, to protect against 
runaway or overspeed with possible personal injury, loss of life, or 
property damage. 

 

 
 

Automotive 
Applications 

On- and off-highway Mobile Applications: Unless Woodward's 
control functions as the supervisory control, customer should install 
a system totally independent of the prime mover control system that 
monitors for supervisory control of engine (and takes appropriate 
action if supervisory control is lost) to protect against loss of engine 
control with possible personal injury, loss of life, or property 
damage. 
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Battery Charging 
Device 

To prevent damage to a control system that uses an alternator or 
battery-charging device, make sure the charging device is turned off 
before disconnecting the battery from the system. 

 
 
 
 

Electrostatic Discharge Awareness 
 

 
 

Electrostatic 
Precautions 

Electronic controls contain static-sensitive parts. Observe the 
following precautions to prevent damage to these parts: 
 Discharge body static before handling the control (with power to 

the control turned off, contact a grounded surface and maintain 
contact while handling the control). 

 Avoid all plastic, vinyl, and Styrofoam (except antistatic 
versions) around printed circuit boards. 

 Do not touch the components or conductors on a printed circuit 
board with your hands or with conductive devices. 

To prevent damage to electronic components caused by improper 
handling, read and observe the precautions in Woodward manual 
82715, Guide for Handling and Protection of Electronic Controls, 
Printed Circuit Boards, and Modules. 

 
Follow these precautions when working with or near the control. 
1. Avoid the build-up of static electricity on your body by not wearing clothing 

made of synthetic materials. Wear cotton or cotton-blend materials as much 
as possible because these do not store static electric charges as much as 
synthetics. 

2. Do not remove the printed circuit board (PCB) from the control cabinet 
unless absolutely necessary. If you must remove the PCB from the control 
cabinet, follow these precautions: 

  Do not touch any part of the PCB except the edges. 
  Do not touch the electrical conductors, the connectors, or the 

components with conductive devices or with your hands. 
  When replacing a PCB, keep the new PCB in the plastic antistatic 

protective bag it comes in until you are ready to install it. Immediately 
after removing the old PCB from the control cabinet, place it in the 
antistatic protective bag. 
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Chapter 1. 
General Information 

 
 
Two versions of ToolKit Service Tool are available for use with the PCM128-HD: 
 
1. ToolKit Professional is a licensed software tool that enables the application 

engineer to modify or create new screens for service configuration. At the 
point of creating new screens, ToolKit Professional is used to: 
 Configure the control software to the specific site or application needs 
 Monitor and tune system variables that were selected in the GAP 

application program 
 Trend variables 
 Upload and download all tuneable and configuration variables from the 

control 
 
2. The standard ToolKit is a software tool that does not have the capability to 

modify screens. Otherwise, it provides the same functionality as ToolKit 
Professional. 

 
Woodward’s ToolKit software may be downloaded from the Woodward website 
(www.woodward.com/software/software.cfm). Alternatively, a ToolKit CD Install 
Kit may be purchased from your Woodward distributor. Once downloaded, the 
kit’s Setup.exe program will guide the user through the installation of ToolKit. 
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Chapter 2. 
Using ToolKit Service Tool 

 
 

Introduction 
 
The following is a brief list of instructions for using Woodward’s ToolKit service 
tool to view/change the variables for your PCM128-HD control with a PC 
(personal computer). These instructions are meant to be introductory only. 
Following the brief instructions list below are more in-depth steps for using 
ToolKit. Full on-line help is available in each application. It is assumed that you 
already have ToolKit software installed and the control has a valid application 
running. 
 
 

PCM128-HD to PC Wiring for ToolKit Communication 
 
Connect the PC’s serial communication port to the PCM128-HD control’s SCL+ 
(J1 B22) and SCL– (J1 B23) pins using an RS-485-to-RS-232 converter (such as 
B&B Electronics Model 485SD9TB, Woodward P/N 1784-1038). The SCL+ line 
connects to the TD (B) pin on the converter, and the SCL– line connects to the 
TD (A) pin on the converter. Alternatively, an RS-485-to-USB converter (such as 
B&B Electronics Model USOTL4, Woodward P/N 1784-1037) can be used to 
connect the PC’s USB port to the PCM128-HD control. (Refer to the USOTL4 
datasheet, available on the B&B Electronics website [www.bb-elec.com/], for 
proper wiring and dip-switch settings for RS-485-to-USB connectivity.) 
 

 
 

Figure: 2-1. Connecting the PCM128-HD to a PC 
 
 

Establishing Communication 
 
Step 1—Opening a ToolKit File 
Before communications can begin between the ToolKit software and the 
PCM128-HD, a ToolKit project file should be opened. To open a ToolKit project 
file, select Open Tool under the File menu. ToolKit files have either a .wtool or 
.wprj file extension. The file browser will open in your default location for projects 
as configured in ToolKit Defaults. You do not need to be connected to a control 
to open a project file. 
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Step 2—Connecting to the PCM128-HD 
1. Make sure that all other programs or devices that may access your 

computer’s communication port are shut down. 
 
2. Select Connect from the Communication menu in ToolKit. The user must 

select the COM port (unless the correct port is configured as the default in 
the Options… dialog of the Tools menu). ToolKit automatically detects the 
baud rate of the control. 

 

 
 
 

Downloading the GAP Application Code 
 
The PCM128-HD may be shipped from the factory with a default GAP program. If 
there is a default GAP application and a new application needs to be loaded, the 
download process only requires the control to be connected to the RS-485 port, 
via a USB-to-RS-485 or RS-232-to-RS-485 converter, and selecting the option 
Load Application from the File menu. This will start the Load Application Wizard. 
 

 
 

Personal Injury 

Be sure the engine is shut down before downloading. Damage to the 
engine or even serious personal injury can result if the engine is 
running during the download procedure. 

 
Download the Application File 
1. Select the option Load Application from the File menu. 
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2. A warning screen will ask that the user make sure the prime mover is shut 
down before downloading. When the warning screen has been addressed 
by clicking Next >, the application file (SCP) to load into the PCM128-HD 
must be selected. 

 

 
 
3. Once the file is selected, click Next > to begin the download. The 

PCM128-HD will automatically reboot and start a boot loader to accept the 
new program. 

 

 
 

 
 
 After the new connection is established (automatically), the new application 

download will begin. A progress meter indicates the download status. 
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 The download process should not be interrupted or cancelled. If it is, there 
may not be a valid application in the PCM128-HD. Another attempt to 
download may be possible, but in the event that the previous application has 
been erased, the only means to re-program the control is by using the 
special hard-boot mode harness configuration detailed earlier in this section. 

 
4. When downloading is complete, the control will reboot automatically. When 

the reboot is completed, the control will begin execution of the new 
application program. 

 
5. After downloading an application, the user may desire to reload the 

application settings (if applicable). See the Settings section for instructions. 
 
 

Settings Files 
 
This section discusses how to work with Settings Files in ToolKit. Settings Files 
that are saved offline can be viewed offline and can be edited offline. 
 
To work with settings files, select Settings menu. 
 

 
 
Saving Settings Files from control (PCM128-HD) 
To save the current Settings File from the control, the tool must be connected to 
the control to use this option. If no connection is present, an error window will be 
displayed. If a connection is present, a Save Settings Wizard will appear. 
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To save the settings, first browse for the directory and file name (if you want a 
new file name, simply type it in) in which to save the settings. Then select Next >. 
Then the control will initialize and upload (save) the settings. 
 

 
 
View/Edit a Settings File 
If a settings file is already present, it can be viewed and edited offline. Go to the 
‘Settings' menu and click on ‘Edit Setting File’. The file will have a .wset 
extension. 
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Loading Settings into the Control (PCM128-HD) 
If a settings file is present and you want to load it to the control (PCM128-HD), 
the tool must be connected to the control to use this option. If no connection is 
present, an error window will be displayed. If a connection is present, a Save 
Settings Wizard will appear. Go to the ‘Settings’ menu and click on ‘Load 
Settings File to Device’. It will ask for the location of the settings file saved in the 
PC. 
 

 
 
Select the appropriate file and click on the ‘Next >’ button. 
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Select network ‘COM1’ and baud rate ‘auto detection’ and click on Next >. 
 

 
 
It will load the settings file into the control. 
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Chapter 3. 
Troubleshooting 

 
 

Introduction 
 
The following troubleshooting guide is an aid in isolating trouble to the ToolKit 
and PC communication. 
 

SYMPTOM CAUSE REMEDY 

Communication is 
not established 
between control 
and PC 

1. Control is not powered 
on. 

Check the control & ensure 
that control is powered 
ON. 

2. Communication wires 
open/broken. 

Check wiring on both ends. 

3. RS 485 to RS-232 
convertor is faulty. 

Replace the convertor. 

 
 

How to Contact Woodward 
 
For assistance, call one of the following Woodward facilities to obtain the address 
and phone number of the facility nearest your location where you will be able to 
get information and service. 
 
 Facility Phone Number 
 Brazil +55 (19) 3708 4800 
 China +86 (512) 6762 6727 
 Germany +49 (711) 78954-510 
 India +91 (129) 4097100 
 Japan +81 (43) 213-2191 
 Korea +82 (51) 636-7080 
 The Netherlands +31 (23) 5661111 
 United States +1 (970) 482-5811 
 
You can also locate your nearest Woodward distributor or service facility on our 
website at: 

www.woodward.com/directory 
 



 

 

 

We appreciate your comments about the content of our publications. 

Send comments to: icinfo@woodward.com 

Please reference publication 51498. 

 
 
 
 

 

 

 

12th Floor, Tower-A, Building – 5, Epitome, DLF City, Phase – III 
Gurgaon, Haryana - 122 002, India 

Phone +91 (124) 4399500  Fax +91 (124) 4399599 

Email and Website—www.woodward.com 

Woodward has company-owned plants, subsidiaries, and branches, as well as authorized distributors and 
other authorized service and sales facilities throughout the world. 

Complete address / phone / fax / email information for all locations is available on our website. 

 


